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Resumen 

Venus es considerado el planeta gemelo de nuestro planeta, no obstante, su atmósfera evoluciono 

de manera muy distinta a la nuestra. La distinta evolución de la atmósfera de Venus convierte al 

planeta en un gran atractivo para el estudio. La atmósfera venusiana está compuesta por una densa 

capa de nubes que envuelve el planeta y provoca un efecto invernadero desbocado.  

La misión Venus Express realizo observaciones a uno de los vórtices polares, el ubicado en el 

polo sur del planeta. Utilizando el espectrómetro VIRTIS-M se realizaron varias imágenes en el 

infrarrojo para estudiar la dinámica del vórtice tanto en la capa alta como en la capa baja de las 

nubes de Venus. Para el estudio de la capa baja de las nubes se utilizaron imágenes en 1.7 µm y 

para el estudio de la capa alta se utilizaron imágenes en 5.1 µm. 

Mediante el software desarrollado por el grupo de Ciencias Planetarias de la Universidad del País 

Vasco, PLIA, se trataron las imágenes de la misión Venus Express y con el software PICV3 

desarrollado por el mismo grupo, se analizaron los vientos zonales y meridionales en la región 

del vórtice del polo sur de Venus. 

El estudio de la dinámica del vórtice polar sur de Venus podría ayudar a comprender en mejor 

medida la dinámica de la atmósfera de Venus, y ayudarnos a comprender mejor nuestra propia 

atmósfera y su posible evolución. 

 

Abstract 

Venus is considered the twin planet of our planet, however, its atmosphere evolved very 

differently from ours. The different evolution of the atmosphere of Venus makes the planet a great 

attraction for study. It is composed of a dense layer of clouds that envelops the planet and causes 

a runaway greenhouse effect. 

The Venus Express mission made observations of one of the polar vortexes, the one located at the 

planet's south pole. Using the VIRTIS-M spectrometer, several infrared images were taken to 

study the dynamics of the vortex in both the upper and lower layers of Venus clouds. For the 

study of the lower layer of the clouds, 1.7 µm images were used and for the study of the upper 

layer of the clouds, 5.1 µm images were used. 

Using the software developed by the Planetary Sciences Group of the University of the Basque 

Country, PLIA, the images of the Venus Express mission were processed and with the PICV3 

software developed by the same group, the zonal and meridional winds in the region of the south 

polar vortex of Venus were analysed. 
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Studying the dynamics of Venus south polar vortex could help us to understand better the 

dynamics of Venus atmosphere and help us to understand better our own atmosphere and its 

possible evolution. 

Laburpena 

Artizarra gure planetaren bikitzat hartzen da; hala ere, haren atmósfera ez da gurea bezalakoa. 

Artizarraren atmósferaren bilakaera desberdina izan denez, planeta oso erakargarria da 

azterketarako. Atmósfera planeta inguratzen duen eta berotegi-efektua eragiten duen hodei-

geruza lodi batek osatzen du. 

Venus Express misioak behaketak egin zizkion planetaren hegoaldeko poloan kokatutako 

bortizeari. VIRTIS-M espektrometroa erabiliz, zenbait irudi egin ziren infragorrian, Artizarraren 

hodeien goi-geruzan nahiz behe-geruzan bortizearen dinamika aztertzeko. Hodeien beheko 

geruza aztertzeko, 1.7 µm-ko irudiak erabili ziren, eta goiko geruza aztertzeko, 5.1 µm-ko irudiak. 

Euskal Herriko Unibertsitateko Zientzia Planetarioen Taldeak garatutako PLIAsoftwarearen 

bidez, Venus Express misioaren irudiak aztertu ziren eta talde berak garatutako PICV3 softwareen 

bidez, Artizarraren hegoaldeko poloko bortizearen haize zonal eta meridionalak aztertu ziren. 

Artizarraren hegoaldeko bortize polarraren dinamika aztertuta, Venusen atmósferaren dinamika 

hobeto ulertzen lagun genezake, eta baita gure atmósfera eta haren bilakaera hobeto ulertzen.  



ESTUDIO TRIDIMENSIONAL DE LOS VIENTOS DEL VÓRTICE POLAR SUR DE VENUS   MEMORIA 

 
 
 

 pág. 5 

 

  



ESTUDIO TRIDIMENSIONAL DE LOS VIENTOS DEL VÓRTICE POLAR SUR DE VENUS   MEMORIA 

 
 
 

 pág. 6 

Índice General 
Introducción ............................................................................................................................... 13 

Venus ...................................................................................................................................... 13 

Vórtice sur de Venus ............................................................................................................. 16 

VIRTIS ................................................................................................................................... 18 

Metodología ............................................................................................................................... 22 

PLIA ....................................................................................................................................... 22 

PICV3 ..................................................................................................................................... 24 

Metodología del análisis ........................................................................................................ 25 

Cálculo de errores ................................................................................................................. 33 

Resultados .................................................................................................................................. 35 

Tratado de imágenes ............................................................................................................. 35 

Seguimiento de las nubes en PICV3 .................................................................................... 39 

Mapas de viento y vorticidad ............................................................................................... 47 

Conclusiones .............................................................................................................................. 55 

 

 



ESTUDIO TRIDIMENSIONAL DE LOS VIENTOS DEL VÓRTICE POLAR SUR DE VENUS   MEMORIA 

 
 
 

 pág. 7 

  



ESTUDIO TRIDIMENSIONAL DE LOS VIENTOS DEL VÓRTICE POLAR SUR DE VENUS   MEMORIA 

 
 
 

 pág. 8 

Índice de figuras 

Figura 1. Perfil de temperatura de la atmósfera de Venus. Los datos fueron obtenidos por la 

sonda Pioneer Venus [2]. ............................................................................................................ 13 

Figura 2. Efecto invernadero desbocado en Venus en comparación con la Tierra [6]. .............. 14 

Figura 3. Circulación atmosférica de Venus [6]. ....................................................................... 15 

Figura 4. Diferentes puntos de análisis en la nube de Venus en función de la longitud de onda.

 ..................................................................................................................................................... 16 

Figura 5. Perfiles de vientos zonales (izquierda) y meridionales (derecha) en la nube superior 

[3]. La línea continua muestra el valor promedio y las líneas discontinuas horizontales y la 

región sombreada la dispersión del promedio. El perfil discontinuo representa los datos 

obtenidos por [8]. ........................................................................................................................ 17 

Figura 6. Imágenes del vórtice polar sur obtenidas por el instrumento VIRTIS. ....................... 18 

Figura 7. Principales características del instrumento VIRTIS [11]............................................ 19 

Figura 8. Espectro infrarrojo de la atmósfera de Venus, que muestra algunas ventanas de 

visualización de las diferentes capas de nubes. Fuente: Garate-López, 2014. [15]. ................... 20 

Figura 9. Espectro infrarrojo de Venus a partir de las observaciones con el instrumento VIRTIS 

mostrando ventanas de observación características en la atmósfera de Venus. .......................... 23 

Figura 10. Interfaz del software PLIA. ...................................................................................... 24 

Figura 11. Interfaz de la extensión de PLIA para en análisis de los vientos PICV3. ................. 25 

Figura 12. Panel de selección de longitud de onda de las imágenes obtenidas por VIRTIS en el 

software PLIA. ............................................................................................................................ 26 

Figura 13. Ventana de información de la imagen seleccionada ................................................. 26 

Figura 14. Panel de la selección de los valores máximos y mínimos de contraste. ................... 27 

Figura 15. Menú para definir las condiciones para la proyección polar de la imagen a estudiar 

en el software PLIA. ................................................................................................................... 28 

Figura 16. Panel de la sección de Edit Options>Map Parameters de la extensión PICV3 del 

software PLIA. ............................................................................................................................ 29 

Figura 17.  Panel de la sección de Edit Options>Algorithm Parameters de la extensión PICV3 

del software PLIA. ...................................................................................................................... 29 

Figura 18. Panel de la sección de Edit Options>Data Save Parameters de la extensión PICV3 

del software PLIA. ...................................................................................................................... 30 

Figura 19. Panel de seguimiento del análisis de los vientos en la extensión PICV3. ................ 30 

Figura 20. Figura 20.  Mapa de correlación junto a las imágenes muestreadas del panel de 

seguimiento del análisis de los vientos en la extensión PICV3................................................... 31 



ESTUDIO TRIDIMENSIONAL DE LOS VIENTOS DEL VÓRTICE POLAR SUR DE VENUS   MEMORIA 

 
 
 

 pág. 9 

Figura 21. Ejemplo del archivo de texto con los resultados del seguimiento realizado en la 

extensión PICV3. ........................................................................................................................ 32 

Figura 22. Velocidad del viento zonal para la nube inferior en la órbita 565. Los puntos 

naranjas representan las medidas de viento realizadas en este proyecto. Los puntos azules las 

medidas previas realizadas por [16]. ........................................................................................... 32 

Figura 23. Imágenes obtenidas por VIRTIS en 1.7 micras de la órbita 565 de Venus Express 

procesadas con el software PLIA. ............................................................................................... 36 

Figura 24. Imágenes obtenidas por VIRTIS en 5.1 micras de la órbita 565 de Venus Express 

procesadas con el software PLIA. ............................................................................................... 36 

Figura 25. Imágenes obtenidas por VIRTIS en 1.7 micras de la órbita 567 de Venus Express 

procesadas con el software PLIA. ............................................................................................... 37 

Figura 26. Imágenes obtenidas por VIRTIS en 5.1 micras de la órbita 567 de Venus Express 

procesadas con el software PLIA. ............................................................................................... 37 

Figura 27. Imágenes obtenidas por VIRTIS en 1.7 micras de la órbita 571 de Venus Express 

procesadas con el software PLIA. ............................................................................................... 38 

Figura 28. Imágenes obtenidas por VIRTIS en 5.1 micras de la órbita 571 de Venus Express 

procesadas con el software PLIA. ............................................................................................... 38 

Figura 29. Medidas individuales obtenidas para los vientos meridionales (V) y zonales (U) del 

vórtice polar sur en 1.7 micras en las tres órbitas estudiadas (puntos naranjas), en comparación a 

estudios previos (Rodríguez-Ovalle & Garate-Lopez, 2021). ..................................................... 40 

Figura 30. Medidas individuales obtenidas para los vientos meridionales (V) y zonales (U) del 

vórtice polar sur en 5.1 micras en las tres órbitas estudiadas (puntos naranjas), en comparación a 

estudios previos (Rodríguez-Ovalle & Garate-López, 2021). ..................................................... 41 

Figura 31. Medidas filtradas para los vientos meridionales (V) y zonales (U) del vórtice polar 

sur en 1.7 micras en las tres órbitas estudiadas (puntos naranjas), en comparación a estudios 

previos (Rodríguez-Ovalle & Garate-Lopez, 2021). ................................................................... 42 

Figura 32. Medidas filtradas para los vientos meridionales (V) y zonales (U) del vórtice polar 

sur en 5.1 micras en las tres órbitas estudiadas (puntos naranjas), en comparación a estudios 

previos (Rodríguez-Ovalle & Garate-López, 2021). ................................................................... 43 

Figura 33. Mapa de los vectores de viento obtenido ejecutando la subrutina 

Draw_Polar_Vectors_Map en IDL utilizando los datos obtenidos en PICV3 y las imágenes 

tratadas en PLIA de la órbita 565. La imagen de arriba representa la imagen analizada en 1.7 

micras y la de abajo en 5.1 micras. ............................................................................................. 44 

Figura 34. Mapa de los vectores de viento obtenido ejecutando la extensión 

Draw_Polar_Vectors_Map en IDL utilizando los datos obtenidos en PICV3 y las imágenes 

file:///D:/TFM/Memoria/Memoria%20Iñigo%20Lobo.docx%23_Toc146106120
file:///D:/TFM/Memoria/Memoria%20Iñigo%20Lobo.docx%23_Toc146106120
file:///D:/TFM/Memoria/Memoria%20Iñigo%20Lobo.docx%23_Toc146106120
file:///D:/TFM/Memoria/Memoria%20Iñigo%20Lobo.docx%23_Toc146106121
file:///D:/TFM/Memoria/Memoria%20Iñigo%20Lobo.docx%23_Toc146106121
file:///D:/TFM/Memoria/Memoria%20Iñigo%20Lobo.docx%23_Toc146106121
file:///D:/TFM/Memoria/Memoria%20Iñigo%20Lobo.docx%23_Toc146106122
file:///D:/TFM/Memoria/Memoria%20Iñigo%20Lobo.docx%23_Toc146106122
file:///D:/TFM/Memoria/Memoria%20Iñigo%20Lobo.docx%23_Toc146106122
file:///D:/TFM/Memoria/Memoria%20Iñigo%20Lobo.docx%23_Toc146106123
file:///D:/TFM/Memoria/Memoria%20Iñigo%20Lobo.docx%23_Toc146106123
file:///D:/TFM/Memoria/Memoria%20Iñigo%20Lobo.docx%23_Toc146106123


ESTUDIO TRIDIMENSIONAL DE LOS VIENTOS DEL VÓRTICE POLAR SUR DE VENUS   MEMORIA 

 
 
 

 pág. 10 

tratadas en PLIA de la órbita 567 La imagen de arriba representa la imagen analizada en 1.7 

micras y la de abajo en 5.1 micras. ............................................................................................. 45 

Figura 35. Mapa de los vectores de viento obtenido ejecutando la extensión 

Draw_Polar_Vectors_Map en IDL utilizando los datos obtenidos en PICV3 y las imágenes 

tratadas en PLIA de la órbita 571 La imagen de arriba representa la imagen analizada en 1.7 

micras y la de abajo en 5.1 micras. ............................................................................................. 46 

Figura 36. Densidad de datos de la zona de estudio para las diferentes órbitas. La primera fila 

representa la órbita 565. La segunda fila representa la órbita 567. La tercera fila representa la 

órbita 571. Los paneles de la izquierda representan el estudio de la capa inferior de las nubes 

(1.7 micras) y los paneles de la derecha representan el estudio de la capa superior (5.1 micras).

 ..................................................................................................................................................... 48 

Figura 37. Viento meridional de la zona de estudio para las diferentes órbitas. La primera fila 

representa la órbita 565. La segunda fila representa la órbita 567. La tercera fila representa la 

órbita 571. El panel de la izquierda representa el estudio de la capa inferior de las nubes (1.7 

micras) y el panel de la derecha representa el estudio de la capa superior (5.1 micras). ............ 49 

Figura 38. Viento zonal de la zona de estudio para las diferentes órbitas. La primera fila 

representa la órbita 565. La segunda fila representa la órbita 567. La tercera fila representa la 

órbita 571. Los paneles de la izquierda representan el estudio de la capa inferior de las nubes 

(1.7 micras) y los paneles de la derecha representan el estudio de la capa superior (5.1micras).50 

Figura 39. Vorticidad de la zona de estudio para las diferentes órbitas. La primera fila 

representa la órbita 565. La segunda fila representa la órbita 567. La tercera fila representa la 

órbita 571. Los paneles de la izquierda representan el estudio de la capa inferior de las nubes 

(1.7 micras) y los paneles de la derecha representan el estudio de la capa superior (5.1 micras).

 ..................................................................................................................................................... 51 

 

  



ESTUDIO TRIDIMENSIONAL DE LOS VIENTOS DEL VÓRTICE POLAR SUR DE VENUS   MEMORIA 

 
 
 

 pág. 11 

  



ESTUDIO TRIDIMENSIONAL DE LOS VIENTOS DEL VÓRTICE POLAR SUR DE VENUS   MEMORIA 

 
 
 

 pág. 12 

Índice de Tablas 

Tabla 1. Valores de selección en el software PLIA para el estudio de las diferentes capas de la 

nube de Venus. ............................................................................................................................ 27 

Tabla 2. Valores de contraste máximo y mínimo para cada imagen. ......................................... 27 

  



ESTUDIO TRIDIMENSIONAL DE LOS VIENTOS DEL VÓRTICE POLAR SUR DE VENUS   MEMORIA 

 
 
 

 pág. 13 

Capítulo 1 

Introducción 

Este documento es el resumen de una investigación realizada por un alumno del Máster en Ciencia 

y Tecnología Espacial de la Escuela de Ingeniería de Bilbao. El objetivo de la investigación ha 

sido medir los vientos del vórtice atmosférico del polo sur de Venus utilizando distintas 

herramientas de programación. 

Venus 

Para poner el trabajo en contexto es necesario definir las condiciones atmosféricas de Venus, pese 

a ser conocido como “el gemelo de la Tierra” debido a su similitud en tamaño y distancia al Sol, 

Venus cuenta con una atmósfera muy distinta a la de su planeta gemelo.  

La gran densidad de la atmósfera de Venus la convierte ópticamente gruesa, lo que dificulta su 

estudio desde la Tierra o el espacio, y está compuesta por dióxido de carbono y nitrógeno 

molecular (96,5% 𝐶𝑂2 + 3,5% 𝑁2) [2]. 

La superficie tiene una temperatura de 735 K (462 ºC), tanto de día como de noche. Esto se debe 

al efecto invernadero desbocado por culpa de la gran densidad de su atmósfera. La atmósfera de 

Venus está dividida en dos regiones. Comparándola con la de la Tierra, en capas altas tiene un 

comportamiento isotérmico, sin contar el pico de temperatura producido en la Tierra por la 

absorción de la radiación solar ultravioleta por el ozono como se muestra en el perfil de 

temperaturas obtenido por las mediciones de la sonda Pioneer en la fig. 1.  

 

Figura 1. Perfil de temperatura de la atmósfera de Venus. Los datos fueron obtenidos por la 

sonda Pioneer Venus [2]. 
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En la zona inferior de la atmósfera la temperatura disminuye con la altura. En las capas altas el 

balance térmico se ha podido concluir que viene dado por la absorción de la luz solar, sin embargo, 

en las zonas bajas de la atmósfera todavía no se conoce bien [3]. Venus está completamente 

cubierta por una capa densa de nubes, esto hace que la gran parte de la luz solar recibida se refleje 

en las nubes, este efecto también provoca que gran parte de la radiación infrarroja quede atrapada 

dentro como se muestra en la fig. 2.  

 

Figura 2. Efecto invernadero desbocado en Venus en comparación con la Tierra [6]. 

La atmósfera de Venus ha evolucionado de manera distinta que la de la Tierra a lo largo de los 

años: la proporción de D/H es 150 veces la de la Tierra [13]. Su proximidad al Sol ha hecho que 

absorba 1,9 veces más viento solar que la Tierra, lo que ha provocado que Venus perdiera toda su 

agua, prácticamente un océano global entero [5].  

Las cantidades de carbono en la atmósfera de Venus son similares a las de la Tierra, sin embargo, 

en el planeta azul la gran mayoría se encuentra localizada en la corteza, en las rocas calizas y 

conchas marinas [7]. Esto se debe a que la presencia de agua líquida y las bajas temperaturas en 

comparación con Venus hacen que el dióxido de carbono se almacene en forma de carbonatos 

[2].  

Venus rota de manera lenta con un periodo de 243 días y de forma contraria al resto de planetas 

del sistema solar. Sin embargo, Venus cuenta con una atmósfera superrotante con velocidades de 

viento zonales de más de 100 m/s y en la dirección de rotación del planeta [3]. Al rotar de manera 

lenta, las fuerzas de Coriolis son más débiles, lo cual hace que Venus cuente con dos únicas 

células Hadley, una por hemisferio. No obstante, la circulación de Hadley en Venus cuenta con 

grandes incógnitas, ya que el análisis del movimiento de las nubes no se ha podido concluir en la 
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parte oscura de Venus [2]. Una de las incógnitas es la extensión final de la célula, si llega hasta 

el polo o si se corta antes, en latitudes subpolares. 

 

Figura 3. Circulación atmosférica de Venus [6]. 

La capa de nubes de Venus dificulta el estudio sobre la circulación general del planeta. Dentro 

del mismo las condiciones son distintas a diferentes alturas, es por ello por lo que en este estudio 

se han analizado imágenes en distintas longitudes de ondas, que muestran diferentes alturas de la 

atmósfera de Venus, y así intentar comprender la dinámica de la cima de las nubes, es decir, el 

límite superior de las nubes, y la dinámica de las nubes más bajas. Aunque la radiación de 1.74 

micras se genere por debajo de las nubes, las nubes bajas filtran esta radiación cuando pasa a 

través de las nubes; por lo que vemos en las imágenes son las nubes inferiores [9]. En este análisis 

tridimensional se trabajarán imágenes en el infrarrojo para trabajar sobre la parte nocturna del 

planeta, como se muestra en la fig.4; 

• 5.1𝜇𝑚: Emisión infrarroja de las nubes altas para el estudio de las nubes altas 

• 1.7𝜇𝑚: Emisión infrarroja de la baja atmósfera, filtrada por las nubes bajas, para el 

estudio de las nubes bajas 
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Figura 4. Diferentes puntos de análisis en la nube de Venus en función de la longitud de onda. 

Vórtice polar sur de Venus  

Se sabe que en la zona de las nubes de Venus a una altitud de entre 40 y 65 km el flujo está 

fuertemente dominado por un viento zonal en dirección este-oeste [3]. No obstante, como ya se 

ha mencionado anteriormente, pese a tratarse de un planeta que, rota lentamente, posee una 

atmósfera superrotante, la capa de las nubes llega a rotar 60 veces más rápido que el planeta [14]. 

Los vientos zonales pueden llegar a alcanzar velocidades superiores a los 100 m/s en las capas 

superiores de las nubes [3]. La fig. 5 representa el perfil latitudinal de los vientos zonales y 

meridionales a una altura de entre 66-73 Km. En ella se aprecia como el flujo dominante se trata 

del viento zonal. También se ve como los vientos meridionales, a diferencia de los zonales no 

decrecen tan bruscamente de latitudes ecuatoriales hasta la zona del vórtice polar. 



ESTUDIO TRIDIMENSIONAL DE LOS VIENTOS DEL VÓRTICE POLAR SUR DE VENUS   MEMORIA 

 
 
 

 pág. 17 

 

Figura 5. Perfiles de vientos zonales (izquierda) y meridionales (derecha) en la nube superior 

[3]. La línea continua muestra el valor promedio y las líneas discontinuas horizontales y la 

región sombreada la dispersión del promedio. El perfil discontinuo representa los datos 

obtenidos por [8]. 

Venus cuenta con dos grandes vórtices ubicados en sus polos, descubiertos gracias a la misión 

Pioneer Venus de la NASA [12] y confirmados por la misión Venus Express de la ESA [10]. Las 

observaciones mostraron un brillante vórtice con forma de dipolo rodeado por un flujo de aire frío 

que circula alrededor del vórtice. Según [10] el dipolo característico podría provenir del 

hundimiento de material de mayor densidad debajo de material de menor densidad. 

El vórtice polar sur de Venus fue observado por el espectrómetro VIRTIS-M en el canal infrarrojo 

desde la inserción a la órbita de Venus en abril de 2006 hasta octubre de 2008. A partir de esa 

fecha, solo el canal visible del espectrómetro VIRTIS-M y el instrumento VMC (Venus 

Monitoring Camera) pudieron tomar imágenes [9]. Las primeras imágenes del vórtice sur de 

Venus obtenidas por VIRTIS indicaron que tenía un periodo de rotación de -2.48 ± 0.05 días; el 

periodo es negativo ya que el vórtice sigue la dirección de rotación de la atmósfera que es la 

misma que la del planeta, y distinta al resto de planetas del Sistema Solar [10]. Este valor indicó 

que el vórtice del polo sur rota más rápido que el del polo norte, el cual lo hace con un periodo de 

aproximadamente 3 días [10]. Cuenta con un tamaño de aproximadamente 2,200 x 1400 𝐾𝑚2 

orientada por el flujo zonal y cuya estructura esta continuamente destruyéndose y recuperándose 

[9]. 
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Figura 6. Imágenes del vórtice polar sur obtenidas por el instrumento VIRTIS. 

La dinámica del vórtice de Venus cuenta con numerosas incógnitas, no obstante, su observación 

y su análisis poco a poco empiezan a dar frutos y se empieza a comprender su naturaleza. Las 

atmósferas cuentan con fenómenos muy distintos en los distintos planetas del sistema solar, pero 

su estudio nos permite conocer más nuestra propia atmósfera. Venus y la Tierra en épocas pasadas 

contaban con atmósferas muy similares, sin embargo, la evolución de ambas tomo rumbos 

distintos. Los estudios científicos dan a entender que Venus ha perdido gran parte del agua debido 

al impacto del plasma solar [5]. Cuanto más sepamos de la atmósfera de Venus, más sabremos 

sobre COMO puede evolucionar nuestra atmósfera, dándonos ventaja para poder actuar ante 

cualquier anomalía. 

VIRTIS 

El espectrómetro VIRTIS (Visible and InfraRed Thermal Imaging Spectrometer) se diseñó para 

la misión Rosetta de la Agencia Espacial Europea. Los descubrimientos de los vórtices en la 
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misión Pioneer Venus abrieron una nueva ventana de estudio, la observación en el infrarrojo de 

la superficie Venusiana. La misión Venus Express contaba con una gran capacidad de mapeo a 

diferentes resoluciones espectrales, por ejemplo, VIRTIS-M para resoluciones espectrales bajas 

y VIRTIS-H para resoluciones espectrales altas. Para este trabajo se usaron imágenes de baja 

resolución espectral en el infrarrojo (VIRTIS-M infrared) [11]. 

 

Figura 7. Principales características del instrumento VIRTIS [11]. 

VIRTIS-M es el espectrómetro de mapeo de VIRTIS. Cuenta con la cabeza óptica M, dicha 

cabeza está constituida por un telescopio y un espectrómetro que se combinan en el visible y en 

el infrarrojo y que están alineados en un mismo eje óptico [11]. 

Las imágenes espectrales aportan información de una misma zona espacial en diferentes 

longitudes de onda, es por eso, que para el estudio de la dinámica del vórtice en la capa alta o baja 

de las nubes, estas imágenes son de muy alto valor. Con un simple cubo espectral se puede obtener 

información de distintas capas de la nube. Los cubos de datos que se obtienen mediante VIRTIS-

M, se compilan como imágenes monocromáticas en 2-D, en las direcciones espaciales X-Y. El 

tercer eje formado por la compilación es el eje espectral, que abarca el rango de entre 0.25 y 5µm 

[11]. 
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Figura 8. Espectro infrarrojo de la atmósfera de Venus, que muestra algunas ventanas de 

visualización de las diferentes capas de nubes[15].  
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Capítulo 2 

Metodología 

Como ya se ha mencionado anteriormente en la introducción de este trabajo, el estudio de Venus, 

a diferencia de otros planetas del sistema solar, se ve limitado hoy en día por las condiciones 

atmosféricas a las que se encuentra el planeta, que impiden un estudio in situ. Es por eso que a 

día de hoy una de las formas que se tiene de estudiar el planeta es mediante datos de imagen [4]. 

Para analizar y caracterizar la atmósfera de un planeta utilizando datos de imagen es necesario 

hacer un procesado previo de las imágenes para maximizar la utilidad de los datos, entre los 

distintos procesados se pueden encontrar tareas como, por ejemplo: 

• Ajuste del contraste de la imagen 

• Corrección del oscurecimiento al limbo 

• Composición de imágenes en distintas longitudes de onda 

En este estudio se ha utilizado el paquete de software PLIA desarrollado por algunos profesores 

del Máster en Ciencia y Tecnología Espacial de la Escuela de Ingeniería de Bilbao de la 

Universidad del País Vasco (EHU/UPV), para procesar las imágenes y para el análisis 

tridimensional de la región polar sur de Venus. 

PLIA 

PLIA (Planetary Laboratory Image Procesing) es un conjunto de programas escritos en IDL 

(Interactive Data Language), un lenguaje de programación de alto nivel capaz de desarrollar 

interfaces gráficas. Para este proyecto en concreto se ha utilizado PLIA para el sistema operativo 

Windows, no obstante, funciona en cualquier sistema operativo que soporte IDL (Windows, 

MacOS o Linux). 

En este trabajo se analizarán imágenes obtenidas por el espectrómetro de imagen VIRTIS (Visible 

and Infrared Thermal Imaging Spectrometer) en la misión Venus Express. El instrumento VIRTIS 

trabaja en el espectro visible y en el infrarrojo, como se mencionó anteriormente, pero para este 

proyecto se han utilizado dos longitudes de onda concretas en el espectro infrarrojo para analizar 

los vientos del vórtice en las nubes altas (5.1 µm) y bajas (1.7µm). La fig. 5 muestra las ventanas 

de observación más características de la atmósfera de Venus en el infrarrojo [4]. 
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Figura 9. Espectro infrarrojo de Venus a partir de las observaciones con el instrumento VIRTIS 

mostrando ventanas de observación características en la atmósfera de Venus. 

En este proyecto el software PLIA ha sido utilizado para el pre-procesado y proyección de las 

imágenes que muestran una zona concreta del planeta, el polo sur. PLIA cuenta con una extensión, 

llamada PICV3, la cual se ejecuta desde IDL, para la medida de la velocidad del viento. Para esta 

técnica que se basa en el seguimiento de las nubes se selecciona un área de estudio y otro de 

muestreo y píxel por píxel analiza el movimiento de las nubes, se puede hacer de manera 

automática indicando el valor máximo de la función de correlación que se quiere aceptar o de 

manera manual, validando cada una de las medidas. 

Una vez acabado el muestreo se mostrarán las direcciones de los vectores de viento, así como su 

módulo. Los intervalos de tiempo deben de definirse antes, después de tratar las imágenes en 

PLIA. 

La interfaz de PLIA cuenta con una variedad de secciones como se muestra en la fig. 10. Se puede 

ver COMO una vez importada la imagen dentro del programa a la derecha hay una sección que 

proporciona una imagen más ampliada de la región seleccionada (cuadrado negro) dentro de la 

imagen principal. En ella se aprecian datos como los valores máximos y mínimos de contraste o 

el número de pixeles del zoom. Debajo del apartado de zoom se especifica información extraída 

de la cabecera de la imagen o de los datos previamente especificados que vienen con la imagen. 
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Figura 10. Interfaz del software PLIA. 

Dentro de la sección Contrast, en la barra superior de la interfaz se pueden seleccionar los valores 

máximos y mínimos de contraste en función de la imagen que se haya seleccionado para contrastar 

bien la imagen que se quiere estudiar. Esta herramienta es bastante útil ya que, para este trabajo 

al tratarse de imágenes espectrales en varias longitudes de onda, estos valores de luminosidad 

varían dentro del rango espectral que se estudia. 

Por otro lado, en la misma barra de la interfaz se encuentra el apartado Qube operations. En este 

apartado se van a poder realizar varias operaciones sobre la imagen. Para este proyecto se han 

utilizado los distintos filtros que se pueden aplicar dependiendo de la altitud que se quiera estudiar 

en las nubes de Venus (parte alta de las nubes o parte baja). También se ha utilizado para 

seleccionar distintas longitudes de onda para una misma imagen. 

El último paso del procesado de la imagen es realizar la proyección polar de la imagen dentro del 

apartado Analysis. La proyección es polar debido a que el polo sur es la región de estudio, dicha 

proyección es la misma para todas las imágenes, de 0.1º/píxel, hasta los 45º de latitud en el 

hemisferio sur. 

PICV3 

Una vez el tratamiento de las imágenes a estudiar ha concluido y las imágenes se han guardado 

de manera correcta, se procede a abrir la extensión PICV3 para la medida de los vientos, la fig. 

11 muestra como se ve la interfaz de PICV3. 
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Una vez insertadas las imágenes, se definen las condiciones para comenzar con el análisis en el 

apartado Edit Options. Una vez definidas, se selecciona en la propia imagen la región a estudiar 

y se comienza el seguimiento pulsando en la sección Start Tracking. 

 

Figura 11. Interfaz de la extensión de PLIA para en análisis de los vientos PICV3. 

 

Metodología del análisis 

Antes de comenzar con la primera parte del análisis, el tratamiento de las imágenes en PLIA, es 

importante seleccionar cuales van a ser las imágenes para estudiar, para ello se requiere una 

selección previa. Las imágenes se obtuvieron de la página web del Planetary Science Archive 

(http://www.rssd.esa.int/PSA). Se obtuvieron imágenes de tres órbitas distintas (órbitas 565, 567 

y 571). Debido a que la nave Venus Express tardaba 24 horas en completar una órbita alrededor 

del planeta, cada órbita representa un día distinto. Para cada órbita se seleccionó una pareja de 

dos imágenes en dos longitudes de onda distintas para la parte superior e inferior de las nubes. 

Los archivos de imágenes vienen distinguidos por órbitas, cada órbita tiene tres tipos de archivos 

distintos; 

• Calibrated 

• Geometry 

• Raw 

 

http://www.rssd.esa.int/PSA
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Una vez ejecutado el software PLIA desde IDL lo primero que hay que hacer es seleccionar la 

imagen para su consiguiente tratado, para ello en la barra superior se selecciona la sección 

File>Open>Venus Express>Calibrated VIRTIS y se selecciona una imagen dentro del archivo de 

Calibrated (.CAD). 

Una vez tengamos la imagen en la interfaz, se selecciona la longitud de onda en la que se quiere 

trabajar. Para ello en la barra superior se selecciona el apartado Qube Operations>Select Data 

Plane; se abrirá un panel como el que se muestra en la fig. 8. 

 

Figura 12. Panel de selección de longitud de onda de las imágenes obtenidas por VIRTIS en el 

software PLIA. 

Para comprobar si la longitud de onda seleccionada es la correcta, una vez indicado el valor en el 

index, en el panel que aparece en la sección de abajo a la derecha de la interfaz de PLIA, se 

muestra información adicional de la imagen, en el que se encuentra el valor de la longitud de onda 

como se muestra a continuación en la fig. 13. 

 

Figura 13. Ventana de información de la imagen seleccionada 

Los valores de índex seleccionados en este proyecto son las correspondientes a dos ventanas de 

observación en el espectro infrarrojo y que permiten estudiar las nubes altas y las nubes bajas, tal 

y como muestra la siguiente tabla: 
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Índex Longitud de onda (µm) Zona de estudio 

75 1.73 Nube superior 

431 5.11 Nube inferior 

Tabla 1. Valores de selección en el software PLIA para el estudio de las diferentes capas de la 

nube de Venus. 

Después de haber seleccionado la longitud de onda se procede a contrastar la imagen de la mejor 

manera posible, cuanto más contrastada sea la imagen, mejor van a ser los resultados en el análisis 

de los vientos. El contraste se modifica en la sección Contrast>Specify Visualization Levels, se 

abrirá un panel como el que se muestra en la fig. 14. 

 

Figura 14. Panel de la selección de los valores máximos y mínimos de contraste. 

Cada imagen tiene unos valores distintos de contraste, incluso dentro de las mismas longitudes 

de onda. Para cada imagen los valores máximos y mínimos de contraste han sido: 

Imagen Longitud de onda (µm) Max Min 

VI0565_00 1.7 1500 -150 

VI0565_00 5.1 5700 500 

VI0565_02 1.7 1500 -150 

VI0565_02 5.1 5700 500 

VI0567_00 1.7 1400 -400 

VI0567_01 5.1 1500 300 

VI0567_02 1.7 1400 -400 

VI0567_03 5.1 1500 300 

VI0571_01 1.7 1400 -400 

VI0571_01 5.1 2100 300 

VI0571_03 1.7 1400 -400 

VI0571_03 5.1 2100 300 

Tabla 2. Valores de contraste máximo y mínimo para cada imagen. 

Después de realizar el ajuste de contraste de la imagen, se le aplica un filtro dependiendo de la 

longitud de onda con la que se esté trabajando. Para ello, en la misma sección de la selección de 
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longitud de onda se pulsa en Qube Operations>VIRTIS Low Cloud Filtering o en Qube 

Operations>VIRTIS Upper Cloud Night (5.0mm) Filtering. Para las imágenes en longitudes de 

1.7 mm se usa el filtro VIRTIS Low Cloud Filtering, mientras que para las imágenes de 5.1 mm 

se usa el filtro VIRTIS Upper Cloud Night (5.0mm) Filtering. 

Una vez aplicado el ajuste de contraste y el filtro a la imagen a estudiar, se procede a realizar la 

proyección polar, para ello es importante entrar en el archivo de las imágenes Geometry y pasar 

el .GEO que contiene las coordenadas de las imágenes a la carpeta donde está el archivo 

Calibrated. Una vez estén todos los archivos en orden para realizar la proyección polar, se 

selecciona; Analysis>Geometrical Projections>Polar Projection. Se abrirá un menú como se 

muestra en la fig. 15. Como el estudio va a realizarse sobre el vórtice polar sur de Venus no hace 

falta estudiar todas las latitudes por lo que se acotará el rango y se definirá en el apartado Lower 

latitude de la fig. 15 a 45º. 

 

Figura 15. Menú para definir las condiciones para la proyección polar de la imagen a estudiar 

en el software PLIA. 

Antes de concluir con el tratado de la imagen, las imágenes que se hayan procesado deben de 

guardarse con un nombre específico. Esto se debe a que la extensión PICV3 cuando abre una 

imagen lee los intervalos de tiempos del título de la imagen que abre, por lo que la imagen 

procesada debe guardarse con el siguiente nombre; 

2022_𝑋𝑋𝑀𝑒𝑠_𝑋𝑋𝐷𝑖𝑎_𝑋𝑋𝐻𝑜𝑟𝑎_𝑋𝑋𝑀𝑖𝑛_𝑋𝑋𝑆𝑒𝑔_𝑁𝑜𝑚𝑏𝑟𝑒 

Una vez la imagen ha sido tratada y guardada correctamente, desde IDL se ejecuta la extensión 

PICV3. Una vez aparezca la interfaz de PICV3 hay que abrir la pareja de imágenes que se quiera 
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estudiar, para ello en la barra superior de la interfaz se selecciona Image File>Open Images>Left 

Image o Image File>Open Images>Right Image. No importa qué imagen seleccionar primero. 

A continuación, se definen los parámetros para comenzar con la medida de los vientos, pero antes 

se deben definir las condiciones, en la sección Edit Options se abrirá un panel como el que se 

muestra en la fig. 16. 

 

 

 

 

 

Figura 16. Panel de la sección de Edit Options>Map Parameters de la extensión PICV3 del 

software PLIA. 

El menú desplegado cuenta con varias pestañas: en la primera, Map Parameters, se definirá como 

en la sección de la proyección polar, una latitud máxima de 45º. En la siguiente pestaña, Algorithm 

Parameters, se definen las dimensiones del cuadrado que va a realizar el muestreo, cuanto más 

pequeño sea menos pixeles va a abarcar, por lo que dependiendo de qué zonas se van a estudiar 

es conveniente modificar este parámetro. Para cada pareja de imágenes se han realizado dos 

mediciones, una en el centro del vórtice y otra en las zonas alejadas del vórtice. Para las zonas 

más próximas, las dimensiones del cuadrado eran más pequeñas ya que había zonas más 

turbulentas y era importante tener un análisis más preciso. Sin embargo, en las zonas más alejadas, 

el movimiento del vórtice seguía un movimiento menos caótico por lo que se podía agrandar el 

cuadrado de muestreo. 

 

Figura 17.  Panel de la sección de Edit Options>Algorithm Parameters de la extensión PICV3 

del software PLIA. 
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Una vez definidas las condiciones, en la última pestaña del panel se renombran los ficheros que 

se van a guardar con los valores de los vectores de viento. La fig. 18 muestra la sección Data Save 

Parameters en el que se pueden definir dos nombres distintos para dos archivos, uno son los datos 

obtenidos y el otro hace una media de los datos, para este proyecto solamente se ha utilizado el 

Wind Results Output File. 

 

Figura 18. Panel de la sección de Edit Options>Data Save Parameters de la extensión PICV3 

del software PLIA. 

Para finalizar con el uso de PICV3 para el análisis de los vientos, se realiza el seguimiento en la 

última pestaña de la barra superior de la interfaz: Start Tracking>Simple 2D Correlation. Se abrirá 

una ventana como la que se muestra en la fig. 19. 

 

Figura 19. Panel de seguimiento del análisis de los vientos en la extensión PICV3. 
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Para conseguir unos resultados óptimos es necesario que el seguimiento se realice de manera 

manual, de esta manera la persona que analice los vientos debe validar cada vector. Para ello en 

el panel de seguimiento de la fig. 19 se muestran diferentes ventanas. La ventana de la parte 

superior derecha muestra un mapa de correlación entre las dos imágenes que se están estudiando, 

el tamaño de esa ventana es el que se ha definido en la sección Edit Options>Algorithm 

Parameters. Este mapa de correlación viene justificado en la parte inferior por dos imágenes, 

estas dos imágenes son sobre las que se realiza la correlación, por lo que podemos contrastar si 

se asemejan o no.  

 

Figura 20. Figura 20.  Mapa de correlación junto a las imágenes muestreadas del panel de 

seguimiento del análisis de los vientos en la extensión PICV3. 

Por último, en la sección inferior de izquierda del panel de seguimiento se muestra la dirección 

del vector en la imagen real, sabiendo que el vórtice rota en la dirección de la atmósfera es fácil 

validar los vectores. Sin embargo, al tratarse de un régimen turbulento en algunas regiones, si 

algún vector se escapa del movimiento lógico del vórtice, pero tiene buena correlación es 

importante seleccionarlo, ya que más adelante se hará una limpieza de las medidas comparándolas 

con resultados obtenidos por otros autores. 

Una vez realizado el seguimiento de todas las órbitas para las dos longitudes de onda y para la 

zona central del vórtice y zonas más alejadas, se obtendrá un archivo de texto con distintos valores 

para distintas longitudes y latitudes como se muestra en la siguiente figura. 



ESTUDIO TRIDIMENSIONAL DE LOS VIENTOS DEL VÓRTICE POLAR SUR DE VENUS   MEMORIA 

 
 
 

 pág. 32 

 

Figura 21. Ejemplo del archivo de texto con los resultados del seguimiento realizado en la 

extensión PICV3. 

Estos valores se transfieren a un programa de cálculo para poder realizar diferentes acciones sobre 

los datos, en este caso se ha utilizado Excel. 

Una vez transferido los datos a Excel se comparan todos los datos obtenidos con las medidas 

realizadas previamente por miembros del Grupo de Ciencias Planetarias. Al tratarse de un 

seguimiento manual, algunos vectores están mal, es por eso por lo que hay que contrastar la nube 

de puntos obtenida en este trabajo con resultados publicados. La siguiente gráfica muestra un 

ejemplo de dicha comparación, pero los resultados obtenidos serán descritos e interpretados en 

detalle en el siguiente capítulo.  

 

Figura 22. Velocidad del viento zonal para la nube inferior en la órbita 565. Los puntos 

naranjas representan las medidas de viento realizadas en este proyecto. Los puntos azules las 

medidas previas realizadas por [16]. 
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Los puntos que aparecen fuera de la nube se seleccionan y se eliminan del archivo de notas, para 

finalmente ejecutar las extensiones que van a proporcionar los distintos mapas con información 

sobre la dinámica del vórtice polar sur de Venus. 

Cálculo de errores 

Para calcular la velocidad de los vientos con el software PICV3 mediante el uso de imágenes 

espaciales, se estudia el desplazamiento de las nubes entre imágenes, entendiendo que las nubes 

se mueven a través del flujo de viento con su misma velocidad. Este análisis trae consigo un error 

ligado a la resolución de las imágenes. De esta manera los vientos se calculan de la siguiente 

forma [9]. 

𝑢 = (𝑅 + 𝐻) 𝑐𝑜𝑠 𝜙 
Δ𝜆

Δ𝑡

𝜋

180
 ;      𝑣 = (𝑅 + 𝐻) 

Δ𝜙

Δ𝑡

𝜋

180
 

En donde Δ𝜆 y Δ𝜙 son los desplazamientos de la nube medidos en grados de longitud y latitud, 

respectivamente. Δ𝑡 es el intervalo de tiempo entre la primera imagen y la segunda. R es el radio 

de Venus y H la altitud asociada al nivel de observación [9]. Los datos se pueden reescribir de la 

siguiente manera. 

𝑢 =
Δ𝑋

Δ𝑡
 ;      𝑣 =

Δ𝑌

Δ𝑡
 

Donde Δ𝑋 y Δ𝑌 son los desplazamientos horizontal y vertical de las nubes, respectivamente, en 

el plano de la imagen, de las nubes en metros. El error asociado a la resolución espacial de las 

imágenes originales se puede escribir de la siguiente manera. 

𝛿𝑢 ≈
δ(Δ𝑋)

Δ𝑡
 ;      𝛿𝑣 ≈

δ(Δ𝑌)

Δ𝑡
 

En donde δ(Δ𝑋) y δ(Δ𝑌) son las incertidumbres espaciales. La incertidumbre temporal se puede 

despreciar ya que las imágenes obtenidas por VIRTIS-M cuentan con una precisión de milésimas 

de segundos [9]. Sabiendo que la resolución de la imagen es de 16 km/píxel, que el error de 

navegación es de unos 2.3 km y que todas las imágenes tienen 1h de diferencia entre sí, el error 

cometido en la medición de los vientos es de unos 4 m𝑠−1. 
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Capítulo 3 

Resultados 

En este capítulo se mostrarán todos los resultados obtenidos durante el proceso, desde el tratado 

de las imágenes, hasta los perfiles de viento de las distintas órbitas. Algunos resultados se 

contrastarán con los datos de [15] y [16]..  Para facilitar la compresión se mostrarán y explicarán 

los resultados siguiendo el índice de la metodología. 

Tratado de imágenes 

Como ya se mencionó en la metodología, el primer paso es tratar las imágenes para sacar la mayor 

cantidad de información científica posible. Para ello, desde el software PLIA y aplicando los 

contrastes de brillo de la tabla. 2 a las imágenes que se mencionan en la misma tabla, se 

obtuvieron las siguientes proyecciones polares del vórtice polar sur de Venus. Todas las parejas 

tienen aproximadamente una hora de diferencia entre la primera imagen y la segunda, ya que este 

intervalo de tiempo es lo suficientemente corto para poder identificar estructuras en ambas 

imágenes, y lo suficientemente largo para que el error cometido en las medidas sea aceptable. 
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Figura 23. Imágenes obtenidas por VIRTIS en 1.7 micras de la órbita 565 de Venus Express 

procesadas con el software PLIA. 

 

 

Figura 24. Imágenes obtenidas por VIRTIS en 5.1 micras de la órbita 565 de Venus Express 

procesadas con el software PLIA. 
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Figura 25. Imágenes obtenidas por VIRTIS en 1.7 micras de la órbita 567 de Venus Express 

procesadas con el software PLIA. 

 

 

Figura 26. Imágenes obtenidas por VIRTIS en 5.1 micras de la órbita 567 de Venus Express 

procesadas con el software PLIA. 
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Figura 27. Imágenes obtenidas por VIRTIS en 1.7 micras de la órbita 571 de Venus Express 

procesadas con el software PLIA. 

 

 

Figura 28. Imágenes obtenidas por VIRTIS en 5.1 micras de la órbita 571 de Venus Express 

procesadas con el software PLIA. 
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Seguimiento de las nubes en PICV3 

Después de guardar las imágenes es importante asegurarse que se aprecia un desplazamiento del 

vórtice entre imagen e imagen antes de realizar el seguimiento en PICV3. 

Una vez las imágenes han sido tratadas, se realiza el seguimiento de los vientos en PICV3. Los 

resultados de los análisis vienen dados en archivos de texto por lo que es importante traspasarlos 

a algún programa que permita trabajar con los datos obtenidos, para este proyecto se ha utilizado 

Excel. 

Los resultados de los análisis se contrastan con los datos obtenidos previamente por [16] con la 

misma metodología. 

Las figuras 29 y 30 muestran las medidas realizadas tanto en la zona central del vórtice como en 

el borde para las diferentes órbitas y longitudes de onda.  

Se mostrarán primero los resultados obtenidos en el estudio de la dinámica de los vientos, tanto 

zonales (U) como meridionales (V), de la zona baja de las nubes, observada a 1.7 micras. 
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Figura 29. Medidas individuales obtenidas para los vientos meridionales (V) y zonales (U) 

del vórtice polar sur en 1.7 micras en las tres órbitas estudiadas (puntos naranjas), en 

comparación a estudios previos ([16]. 



ESTUDIO TRIDIMENSIONAL DE LOS VIENTOS DEL VÓRTICE POLAR SUR DE VENUS   MEMORIA 

 
 
 

 pág. 41 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Como se puede apreciar en los resultados obtenidos en las figuras 27 y 28, existen puntos aislados 

que se alejan bastante de los resultados obtenidos previamente. Esos puntos se identifican uno a 

uno y, tras verificarlo en el mapa de vientos, se eliminan del archivo de datos original obtenido 

de los análisis en PICV3, por considerar que no siguen la misma tendencia que las medidas de su 

alrededor. Una vez eliminados se vuelven a representar las gráficas, pero esta vez sin los datos 

erróneos. 

 

 

Figura 30. Medidas individuales obtenidas para los vientos meridionales (V) y zonales (U) del 

vórtice polar sur en 5.1 micras en las tres órbitas estudiadas (puntos naranjas), en comparación a 

estudios previos [16]. 
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Figura 31. Medidas filtradas para los vientos meridionales (V) y zonales (U) del vórtice polar 

sur en 1.7 micras en las tres órbitas estudiadas (puntos naranjas), en comparación a estudios 

previos [16]. 
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Una vez la limpieza de puntos ha concluido y, por tanto, tenemos nuestro conjunto de medidas 

fiables, se reinsertan los datos en un archivo de notas de tal manera que el programa 

Draw_Polar_Vectors_Map pueda leer los valores de vientos zonales y meridionales con sus 

respectivos valores de longitud y latitud. Esta subrutina de IDL dibuja el mapa de las imágenes 

procesadas con los vectores de viento en ella. Los vectores indican la dirección del viento y su 

tamaño representa el módulo, es decir, la velocidad del viento.  

  

Figura 32. Medidas filtradas para los vientos meridionales (V) y zonales (U) del 

vórtice polar sur en 5.1 micras en las tres órbitas estudiadas (puntos naranjas), en 

comparación a estudios previos [16]. 
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Figura 33. Mapa de los vectores de viento obtenido ejecutando la subrutina 

Draw_Polar_Vectors_Map en IDL utilizando los datos obtenidos en PICV3 y las imágenes 

tratadas en PLIA de la órbita 565. La imagen de arriba representa la imagen analizada en 1.7 

micras y la de abajo en 5.1 micras.  
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Figura 34. Mapa de los vectores de viento obtenido ejecutando la extensión 

Draw_Polar_Vectors_Map en IDL utilizando los datos obtenidos en PICV3 y las imágenes 

tratadas en PLIA de la órbita 567 La imagen de arriba representa la imagen analizada en 1.7 

micras y la de abajo en 5.1 micras.  
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Figura 35. Mapa de los vectores de viento obtenido ejecutando la extensión 

Draw_Polar_Vectors_Map en IDL utilizando los datos obtenidos en PICV3 y las imágenes 

tratadas en PLIA de la órbita 571 La imagen de arriba representa la imagen analizada en 1.7 

micras y la de abajo en 5.1 micras. 
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Mapas de viento y vorticidad 

Observando los vectores de viento del vórtice polar sur de Venus, se puede ver como los vectores 

siguen la dirección de la rotación del planeta como se mencionó en la introducción.  

En las imágenes nocturnas en 1.7 micras se observa la dinámica de las nubes a 44-48 Km [3]. Los 

resultados obtenidos muestran como el flujo está dominado por un viento zonal con dirección 

hacia el oeste, el cual crece a medida que nos alejamos del centro del vórtice hacia el borde, 

llegando a tener velocidades de hasta 100 m/s en latitudes de unos 60-50º. Los vientos 

meridionales sin embargo se mantienen más estables a lo largo del vórtice. 

En el análisis de las imágenes nocturnas en 5.1 micras también se aprecia COMO crece la 

velocidad del viento zonal a medida que nos aproximamos a latitudes más ecuatoriales, sin 

embargo, estos vientos zonales de la capa superior de las nubes son más rápidos que en la capa 

inferior de las nubes en latitudes alejadas al polo.  

La nube superior presenta un viento meridional estable, con valores de hasta los ±20 m/s en 

latitudes de unos 70-60º y sin grandes fluctuaciones. En las capas inferiores, sin embargo, aun 

cuando la intensidad del viento es similar que, en la capa superior, los valores cuentan con 

variaciones más bruscas. Esta característica podría interpretarse como un régimen meridional más 

turbulento en las capas bajas. 

Una vez obtenidos los perfiles de viento con el programaPICV3, se pueden calcular otros 

parámetros físicos y obtener mapas con más información, aportando los archivos de notas con los 

valores de los vientos meridionales y zonales para las distintas longitudes y latitudes. 

En este proyecto se ha calculado la vorticidad relativa, es decir, el grado de rotación local de la 

atmósfera, en la región polar sur de Venus y a dos alturas, correspondientes a la nube inferior y 

a la cima de nubes. Para ello, se ha hecho uso de la subrutina Polar_Winds_Analysis escrita en 

IDL por miembros del Grupo de Ciencias Planetarias de la UPV/EHU.  
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Figura 36. Densidad de datos de la zona de estudio para las diferentes órbitas. La primera fila 

representa la órbita 565. La segunda fila representa la órbita 567. La tercera fila representa la 

órbita 571. Los paneles de la izquierda representan el estudio de la capa inferior de las nubes 

(1.7 micras) y los paneles de la derecha representan el estudio de la capa superior (5.1 micras). 
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Figura 37. Viento meridional de la zona de estudio para las diferentes órbitas. La primera fila 

representa la órbita 565. La segunda fila representa la órbita 567. La tercera fila representa la 

órbita 571. El panel de la izquierda representa el estudio de la capa inferior de las nubes (1.7 

micras) y el panel de la derecha representa el estudio de la capa superior (5.1 micras). 
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Figura 38. Viento zonal de la zona de estudio para las diferentes órbitas. La primera fila 

representa la órbita 565. La segunda fila representa la órbita 567. La tercera fila representa la 

órbita 571. Los paneles de la izquierda representan el estudio de la capa inferior de las nubes 

(1.7 micras) y los paneles de la derecha representan el estudio de la capa superior (5.1micras). 
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Figura 39. Vorticidad relativa de la zona de estudio para las diferentes órbitas. La primera fila 

representa la órbita 565. La segunda fila representa la órbita 567. La tercera fila representa la 

órbita 571. Los paneles de la izquierda representan el estudio de la capa inferior de las nubes 

(1.7 micras) y los paneles de la derecha representan el estudio de la capa superior (5.1 micras). 



ESTUDIO TRIDIMENSIONAL DE LOS VIENTOS DEL VÓRTICE POLAR SUR DE VENUS   MEMORIA 

 
 
 

 pág. 52 

Mapa densidades 

Este mapa representa la cantidad de datos que se han obtenido en la región estudiada, sirve para 

evaluar la fiabilidad de las interpretaciones. Las regiones que cuentan con una baja densidad de 

datos serán menos fiables que las basadas en un gran número de medidas. Es decir, si vemos que 

el viento acelera en una zona, esa conclusión será más contundente si se basa en 10 medidas que 

en 1. 

Viento meridional 

La definición de meridional se basa en alejarse o acercarse del polo planetográfico, es por eso por 

lo que existe tanta variación de valores positivos y negativos, ya que como se aprecia en la figura 

37 hay gran variedad de valores positivos y negativos. En los datos de la órbita 565 se puede 

apreciar como en el estudio de la capa inferior los valores de viento son en gran mayoría positivos, 

por el contrario, en la capa superior los valores son negativos, dando a entender que los flujos 

meridionales en las capas altas y bajas de la nube van en dirección contraria. 

La misma conclusión se podría sacar de la órbita 567 ya que se puede apreciar como en el estudio 

de la capa inferior, la velocidad del viento es positiva, y en la capa superior se aprecian regiones 

donde el flujo va en dirección contraria. 

Este resultado da a entender que la dinámica de los vientos meridionales es distinta en las 

diferentes capas de la nube, no se mueven ni a la vez ni de la misma manera. 

Viento zonal 

Al contrario de lo que se esperaría, no se observa un mapa zonal con valores creciendo según se 

alejan del polo (tal y como sí sucede en la órbita 567, nube inferior). Esto podría indicar un 

cambio en la atmósfera de Venus (algo poco probable debido a la consistencia observada en los 

últimos años), o podría sugerir errores en la medida del viento. No se ha podido verificar esta 

última posibilidad por falta de tiempo.  

Vorticidad 

No se observan estructuras o regiones dominantes, sino más bien una mezcla de estructuras 

pequeñas con valores fluctuantes. Esto parece indicar que toda la atmósfera tiene una misma 

rotación, la general, y, por tanto, en estos mapas no se distinguen movimientos propios del 



ESTUDIO TRIDIMENSIONAL DE LOS VIENTOS DEL VÓRTICE POLAR SUR DE VENUS   MEMORIA 

 
 
 

 pág. 53 

vórtice. No hay regiones (como los brazos exteriores o el centro) que tengas más rotación que 

otras. 
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Capítulo 4  

Conclusiones 
En este proyecto se ha estudiado la dinámica del vórtice polar sur de Venus utilizando distintos 

softwares desarrollados por el grupo de Ciencias Planetarias de la Universidad del País Vasco. 

Mediante PLIA se trataron las imágenes para obtener la mejor calidad posible para su análisis, no 

obstante, no todas las imágenes se trataron de la misma manera. Las imágenes tratadas en 1.7µm 

cuentan con un mayor número de estructuras visibles que las imágenes tratadas en 5.1µm, esta 

característica facilita la obtención de más vectores de viento para un mismo seguimiento en 

PICV3, al tener un mayor valor del factor de correlación a la hora del muestreo entre imágenes.  

En cuanto a los resultados obtenidos en el análisis de viento, cabe destacar que por circunstancias 

ajenas al proyecto el tiempo con que se ha contado para realizar este trabajo ha sido muy corto. 

Es por eso por lo que la densidad de datos en los análisis de las 3 órbitas es bastante baja. Aun 

así, en la comparación con los datos obtenidos en Garate-López et al. (2013), los perfiles de viento 

obtenidos en este trabajo encajan dentro de la nube de puntos de los estudios previos. Se aprecia 

como el flujo está dominado por un viento zonal en dirección hacia el oeste. En la capa de las 

nubes altas (5.1µm) tiene velocidades ligeramente mayores en latitudes más alejadas del polo 60-

50º, dando a entender que a medida que nos acercamos al ecuador esta diferencia será algo mayor. 

La velocidad de los vientos zonales en ambas capas de la nube decrece a medida que se acercan 

al vórtice, siendo casi nula en la región del polo sur. Estas características coinciden con las ya 

observadas en estudios previos. 

Los vientos meridionales parecen mantenerse más estables que los zonales, puesto que no se 

aprecian decrecimientos bruscos como en los vientos zonales. En el estudio de las nubes altas 

(5.1µm), los valores de viento meridional se mantienen más estables entre -2 m𝑠−1 y -8 m𝑠−1, 

pero siempre en la misma dirección. Sin embargo, el flujo de viento zonal en las capas inferiores 

tiene más variaciones que en la capa alta, los valores de velocidad son menores y la dirección 

también cambia, tal y como puede apreciarse en la figura 2. Una de las incógnitas actuales sobre 

la atmósfera de Venus es la extensión de la célula de Hadley, que podría llegar hasta el centro del 

vórtice o tan solo hasta la parte exterior del vórtice, a la zona conocida como cold collar. 

Analizar las condiciones de temperatura y presión atmosférica de la región polar, podría dar más 

información al respecto. De esa manera uniríamos la información cinemática obtenida en este 

trabajo con la información térmica y podríamos estudiar la dinámica atmosférica al completo. 
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